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BAB III 

METODE PENELITIAN 

A. Jenis dan Pendekatan Penelitian 

Penelitian yang digunakan adalah penelitian eksperimen yaitu 

bertujuan mengetahui pengaruh treatment dengan kondisi yang dikendalikan. 

Adapun jenis metode penelitian yang digunakan pada peneltian yaitu quasi 

eksperimen design. Pada jenis penelitian ini, terdapat dua kelompok yaitu 

keals eksperimen dan kelas kontrol.  Pendekatan pada penelitian ini yaitu 

pendekatan kuantitatif. Karena data pada penelitian berupa angka dan analisis 

yang membutuhkan statistik (Sugiyono, 2013). 

B. Desain Penelitian 

Pada penelitian, yaitu desain yang digunakan adalah nonequivalent 

control group design yaitu dengan kelompok eksperimen dan kontrol yang 

dipakai tidak dipilih secara acak (Sugiyono 2017). Kedua kelompok diberikan 

soal pretest untuk mengetahui kemampuan awal keterampilan berpikir kreatif 

peserta didik pada materi kesetimbangan kimia sebelum dilakukan perlakuan 

dan soal posttest sesudah perlakuan. Pada kelas eksperimen diberi perlakuan 

khusus menggunakan pendekatan STEAM. Sedangkan kelas kontrol tetap 

menggunakan model pembelajaran yang biasa diterapkan di sekolah yaitu 

pendekatan scientific, kemudian kedua kelompok diberikan soal posttest untuk 

mengetahui perbedaan dari kedua kelompok tersebut. Desain penelitian yang 

digunakan termuat dalam Tabel 3.1. 
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Tabel 3.1 Desain Penelitian 

Kelompok Prestest Perlakuan Postest 

Eksperimen O1 X1 O3 

Kontrol O2 X2 O4 

 

Keterangan: 

O1 : Pretest  kelas eksperimen 

O2 : Pretest kelas kontrol 

X1 : Perlakuan pembelajaran kelas eksperimen dengan pendekatan STEAM 

X2 : Perlakuan pembelajaran kelas kontrol dengan pendekatan scientific 

O3 : Posstest kelas eksperimen 

O4 : Posstest kelas kontrol 

Di dalam penelitian ini, pendekatan STEAM sebagai variabel bebas, 

keterampilan berpikir kreatif sebagai variabel terikat dan guru sebagai variabel 

kontrol. Untuk mengetahui pengaruh variabel bebas dan variabel terikat dari 

kedua kelas dilihat dari hasil posttest kedua kelas. Perlakuan dikatakan 

berpengaruh terhadap variabel terikat jika skor hasil posttest kelas eksperimen 

lebih tinggi dibandingkan skor hasil posttest kelas kontrol. 

C. Setting Penelitian 

1. Lokasi Penelitian 

Penelitian yang dilakukan bertempat di MAN 3 Banjar yang terletak 

di Jl. Ahmad Yani KM. 15,2 Kecamatan Gambut, Kabupaten Banjar, Provinsi 

Kalimantan Selatan. Alasan pemilihan lokasi penelitian karena adanya 

permasalahan yang ditemukan terkait pembelajaran kimia di MAN 3 Banjar 

khususnya kelas XI MIPA  yaitu kurangnya kreativitas peserta didik karena 
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keterbatasan media pembelajaran. Selain itu peneliti juga mendapatkan 

perizinan dari pihak sekolah baik Kepala Sekolah maupun guru kimia yang 

bersangkutan untuk melakukan penelitian di MAN 3 Banjar. Adapun 

penelitian dilakukan dari tanggal 29 November 2023 hingga 29 Januari 2024. 

2. Populasi dan Sampel 

Populasi merupakan seluruh objek penelitian yang bisa menjadi 

sumber data penelitian (Burhan, 2005). Pada penelitian, populasi yang 

digunakan adalah seluruh kelas XI MIPA di MAN 3 Banjar yang terdiri dari 2 

kelas, yaitu MIPA 1 dan MIPA 2 yang berjumlah 45 peserta didik. Sampel 

merupakan bagian yang dipilih dari populasi (Sudaryono, 2018). Pengambilan 

sampel pada penelitian ini menggunakan teknik puposive sampling, Sampel 

pertama, kelas XI MIPA 1 sebagai kelas ekperimen terdiri dari 23 peserta 

didik dan sampel kedua kelas XI MIPA 2 sebagai kelas kontrol terdiri dari 22 

peserta didik. 

D. Data dan Sumber Data 

1. Data  

a. Data primer 

Data primer yang dikumpulkan bersumber pada pelaksanaan pretest 

sebelum kegiatan pembelajaran dan posttest sesudah selesai kegiatan 

pembelajaran yang berfokus terhadap keterampilan berpikir kreatif peserta 

didik pada materi kesetimbangan kimia. Dengan data primer, diharapkan  

dapat menajdi informasi yang relavan untuk mengukur keterampilan berpikir 

kreatif peserta didik. 
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b. Data sekunder 

Data sekunder pada penelitian bersumber dari dokumen-dokumen 

terkait dengan sekolah MAN 3 Banjar diantaranya hasil lembar observasi 

keterlaksanaan pembelajaran kelas eskperimen dan kelas kontrol serta jadwal 

pembelajaran peserta didik kelas XI MIPA MAN 3 Banjar. 

2. Sumber Data 

Sumber data pada penelitian termuat pada Tabel 3.2. 

Tabel 3.2 Sumber Data  

No Sumber Data Keterangan 

1. Responden Peserta didik kelas XI MIPA 1 dan MIPA 2 MAN 3 

Banjar 

2. Informan Guru kimia kelas XI MIPA dan staf tata usaha MAN 

3 Banjar 

3. Dokumen Berupa gambar, tulisan dan semua dokumen yang 

berkaitan dengan penelitian. 

4. Observer Teman sejawat 

 

3. Teknik Pengumpulan Data 

Teknik pengumpulan data yaitu cara yang dilakukan peneliti untuk 

mengumpulkan data hasil penelitian. Pada penelitian, menggunakan teknik 

pengumpulan data sebagai berikut. 

a. Instrumen Tes 

Pada penelitian tes yang digunakan berupa (pretest dan posttest) 

dalam bentuk essay yang terdiri dari 11 soal. Soal pretest diberikan sebelum 

adanya perlakuan sedangkan posttest setelah diberikan perlakuan pada kelas 

eksperimen dan kelas kontrol yang sudah disesuaikan dengan aspek indikator 

keterampilan berpiir kreatif untuk mengetahui tingkat keterampilan berpikir 
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kreatif peserta didik kelas XI MIPA MAN 3 Banjar pada materi 

kesetimbangan kimia. Aspek indikator yang dimaksud yaitu fluency, 

flexibility, oroginality dan elaboration. Rubrik penskoran yang digunakan 

pada penelitian ini seperti pada Tabel 3.3 (Prasetiyo dkk., 2014). 

Tabel 3.3 Aspek Keterampilan Berpikir Kreatif 

No Indikator Keterangan 

1. Fluent thinking 

(berpikir lancar) 

Kemampuan peserta didik untuk 

mencetuskan banyak ide/gagasan dalam 

pembelajaran. 

2. Fleksible thinking 

(berpikir luwes) 

Kemampuan peserta didik dalam 

menghasilkan ide/ atau gagasan yang 

bervariatif. 

3. Original thinking 

(berpikir orisinil) 

Kemampuan peserta didik dalam 

menciptakan ide/ atau gagasan baru yang 

unik atau belum ada sebelumnya. 

4. Elaboration ability 

(keterampilan 

mengelaborasi) 

kemampuan sesorang untuk mengembangkan 

suatu ide/gagasan yang diperolehnya. 

Sebelum dilakukan penelitian, instrumen tes diuji coba terlebih dahulu 

kepada peserta didik kelas XII MIPA 1 yang sebelumnya sudah pernah 

mempelajari materi kesetimbangan kimia. Uji coba bertujuan untuk 

mengetahui kevalidan instrumen tes yang ingin digunakan. 

b. Observasi 

Penelitian ini menggunakan observasi langsung terhadap proses 

pembelajaran yang dilakukan melalui lembar observasi keterlaksanaan 

pembelajaran pada meteri kesetimbangan kimia kelas eksperimen maupun 

kelas kontrol dengan pengawasan observer dan guru kimia kelas XI MIPA 

MAN 3 Banjar. Tujuan observasi untuk memastikan keterlaksanaan dari 

urutan proses pembelajaran yang sudah ditentukan. 
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c. Dokumentasi 

Dokumentasi bertujuan untuk menghasilkan data berupa catatan-

catatan dan dokumen lain yang berkaitan dengan masalah penelitian berupa 

proses pembelajaran, jadwal pembelajaran dan materi pembelajaran. 

E.  Instrumen Penelitian 

Alat atau instrumen penelitian adalah sesuatu yang biasa digunakan 

dalam mempermudah seseorang untuk melakukan penelitian sehingga 

mencapai tujuan yang diinginkan (Arikunto, 2013). Instrumen yang dipakai 

pada penelitian, adalah instrumen perlakuan dan instrumen pengukuran. 

Instrumen perlakuan dan instrumen pengukuran termuat dalam Tabel 3.4. 

Tabel 3.4 Instrumen Penelitian  

No Jenis Instrumen Instrumen 

1. Instrumen Pengukuran Soal pretest dan posttest berupa essay 

berjumlah 11 soal. 

2. Instrumen Perlakuan Silabus, Rancangan Rencana 

Pembelajaran (RPP) kelas eksperimen 

dan kelas kotrol, Lembar Kerja Peserta 

Didik (LKPD) kelas eksperimen dan 

kelas kontrol, dan lembar keterlaksanaan 

pembelajaran kelas eksperimen dan kelas 

kontrol. 

Sebelum digunakan, seperangkat instrumen tersebut dilakukan validasi 

melalui validator dua dosen Tadris Kimia dan satu guru kimia MAN 3 Banjar. 

Adapun kriteria hasil validasi dilihat pada Tabel 3.5 berikut sebagai acuan 

(Sa‟dun Akbar, 2013). 
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Tabel 3.5 Kriteria Hasil Validitas Instrumen Tes 

No Skor Kriteria Validitas 

1. 81-100% Sangat layak 

2. 61-80% Layak 

3. 41-60% Cukup layak 

4. 21-40% Tidak layak 

5. < 21 % Sangat tidak layak 

Tes yang dipakai pada penelitian mengacu pada aspek indikator 

keterampilan berpikir kreatif yaitu: (1) fluency, (2) flexibility (3) originality 

dan (4)  elaboration. Rubrik penskoran instrumen tes berpikir kretaif  termuat 

dalam Tabel 3.6 (Zaiyar & Rusmar, 2020). 

Tabel 3.6 Rubik Penskoran Keterampilan Berpikir Kreatif 

No Indikator 

Berpikir 

Kreatif 

Indikator 

Penilaian 

Rubrik Skor 

1. Keterampilan 

berpikir lancar 

(fluency) 

Memberikan 

jawaban dengan 

tepat sesuai 

pertanyaan yang 

diterima 

Peserta didik 

memberikan  jawaban 

dengan tepat beserta 

penjelasannya 

4 

Peserta didik mem 

berikan jawaban yang 

kurang 

tepat/mendekati  

beserta penjelasan 

3 

Peserta didik 

memberikan jawaban 

yang kurang 

tepat/mendekati tidak 

disertai penjelasan 

2 

Peserta didik 

memberikan jawaban 

yang salah tidak 

disertai penjelasan 

1 

Peserta didik tidak 

memberikan jawaban 

0 
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No Indikator 

Berpikir 

Kreatif 

Indikator 

Penilaian 

Rubrik Skor 

2. Keterampilan 

berpikir luwes 

Flexibility) 

Menghasilkan 

jawaban yang 

bervariasi 

dengan sudut 

pandang 

berbeda 

Peserta didik mampu 

memberikan jawaban 

dengan tepat dan 

bervariasi dari sudut 

pandang yang berbeda  

4 

Peserta didik 

memberikan jawaban 

yang kurang 

tepat/mendekati dan 

bervariasi dari sudut 

pandang yang berbeda 

3 

Peserta didik 

memberikan jawaban 

kurang tepat/mendekati 

dan kurang bervariasi  

2 

Peserta didik 

memberikan jawaban 

tidak tepat dan tidak 

bervariasi 

1 

Peserta didik tidak 

memberikan jawaban 

0 

3. Keterampilan 

berpikir 

orisinil 

(Originality) 

Memberikan 

jawaban 

menurut 

pemikirannya 

sendiri 

Peserta didik dapat 

memberikan jawaban 

menurut pemikirannya 

sendiri dan jawaban tepat 

4 

Peserta didik 

memberikan jawaban 

bukan dari bahasa dan 

pemikirannya sendiri 

namun jawaban tepat 

3 

Peserta didik 

memberikan jawaban 

bukan dari bahasanya 

sendiri dan jawaban 

kurang tepat/mendekati 

2 

Peserta didik 

memberikan jawaban 

bukan dari bahasanya 

sendiri dan jawaban tidak 

tepat 

1 

Peserta didik tidak 

memberikan jawaban 

0 
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No Indikator 

Berpikir 

Kreatif 

Indikator 

Penilaian 

Rubrik Skor 

4. Keterampilan 

mengelaborasi 

(Elaboration) 

Dapat 

merincikan 

suatu jawaban 

sehingga lebih 

jelas 

Peserta didik mampu 

memberikan jawaban 

secara rinci dengan 

jawaban yang tepat 

4 

Peserta didik 

memberikan jawaban 

yang tidak rinci namun 

jawaban tepat 

3 

Peserta didik 

memberikan jawaban 

tidak rinci dan jawaban 

kurang tepat/mendekati 

2 

Peserta didik 

memberikan jawaban 

tidak rinci dan jawaban 

tidak tepat 

1 

Peserta didik tidak 

memberikan jawaban 

0 

F. Teknik Analisis Data 

Teknis analisis data bertujuan untuk mengolah dan menganalisis data 

keterampilan berpikir kreatif peserta didik. Teknik analisis data yang 

digunakan dalam penelitian ini menggunakan statistika deskriptif dan 

statistika inferensial. 

1. Statistika Deskriptif 

b. Tes Kemampuan Bepikir Kreatif 

Statistika deksriptif digunakan untuk menganalisis data kemampuan 

keterampilan berpiir kreatif peserta didik. Analisis data dilakukan dengan 

langkah sebagai berikut. 
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a. Memberikan skor pada jawaban peserta didik berdasarkan indikator 

keterampilan berpikir kreatif dan menjumlahkan skor pada masing-masing 

aspek indikator berpikir kreatif 

b. Menghitung nilai presentase setiap aspek indikator berpikir kreatif peserta 

didik dengan menggunakan rumus: 

  
                  

             
        

c. Menentukan tingkat katagori keterampilan berpikir kreatif peserta didik 

berdasarkan hasil presentase setiap aspek indikator keterampilan berpikir 

kreatif  

d. Menjumlahkan seluruh skor yang diperoleh peserta didik dan menghitung 

presentase untuk menentukan tingkat katagori keterampilan berpikir 

kreatif peserta didik.  

Pedoman penentuan katagori tingkat kemapuan keterampilan berpikir 

kreatif termuat dalam Tabel 3.7 (Riduwan, 2010). 

Tabel 3.7 Katagori Kemampuan Berpikir Kreatif 

Presentase (%) Katagori 

X > 80 Sangat Kreatif 

60 < x ≤ 80 Kreatif 

40 < x ≤ 60 Cukup Kreatif 

20 < x ≤ 40 Kurang Kreatif 

x ≤ 20 Tidak Kreatif 

2. Uji Prasyarat 

Uji prasyarat pada penelitian ini menggunakan statistika inferensial 

dan terdiri dari uji normalitas dan uji homogenitas dan uji hipotesis. 
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a. Uji Normalitas 

Uji normalitas merupakan suatu prosedur penelitian yang bertujuan 

untuk mengetahui distribusi kenormalan sampel. Uji normalitas dilakukan 

menggunakan software SPSS versi 24 yang diuji dengan Kolmogrov-Sminov 

pada SPSS dengan langkah-langkah sebagai berikut: 

Data View → Analyze → Descriptive Statistic → Eksplore → 

masukan Dependen List → Both → Plots Factor Level Together →   

Normality → Plots with Test → Continue → Ok 

b. Uji Homogenitas 

Uji homogenitas digunakan untuk mengelompokkan data pada 

kelompok homogen atau heterogen berbantuan software SPSS versi 24 

dengan langkah-langkah sebagai berikut: 

Data Frekuensi → Descriptive  Statistics → Explore → Masukkan 

Dependen List Dan Factor List → Plots →  None pada Boxplots →  Stem-

and-Leaf di Deselect → pada Descriptive → Power Estimation pada Speread 

Vs Level With Levene Test → Continue → Ok 

c. Uji Hipotesis  

Pada data postest dan pretest dilakukan uji hipotesis menggunakan 

Software SPSS versi 24 untuk mengevaluasi apakah pembelajaran dengan 

menggunakan pendekatan STEAM berpengaruh terhadap keterampilan 

berpikir kreatif peserta didik pada materi kesetimbangan serta uji Independent 

Sample T-Test untuk menguji signifikansi berbedaan rata-rata nilai antara dua 
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kelompok sampel yang tidak berkolerasi dengan langkah-langkah sebagai 

berikut 

Analyze →  Compare Mean →  Independent Sample T-Test →  Isi Test 

Variabel →  Isi Grouping Variables →  Ok 

Untuk pengambilan keputusan digunakan nilai ɑ sebagai kriteria 

signifikasi. Pada taraf signifikasi 5%, jika thitung > ttabel dan nilai nilai Asymp. 

Sig. (2-tailed) > 0,05 maka H0 diterima dan Ha ditolak.  

G. Teknik Validitas dan Keabsahan Data 

Teknik validitas dan keabsahan data yang digunakan sebelum 

dilakukan penelitian yaitu untuk menganalisis data berikut. 

1. Uji Validitas 

a. Uji Validitas kepada Tim Validator 

Sebelum instrumen digunakan pada  penelitian, penting untuk 

melakukan validasi terlebih dahulu untuk mengetahui kevalidan instrumen 

yang akan dipakai. Proses validasi dilakukan oleh tiga orang validator yang 

terdiri dari dua dosen Tadris Kimia yaitu Bapak Ikhsanul Fatya, S.Pd., M.Pd 

dan Ibu Khairiatul Muna, S.Pd., M.Pd dan satu orang guru kimia MAN 3  

Banjar yaitu Ibu Naimah, S.Pd. Untuk menghiutung presentase hasil validitas 

digunakan rumus sebagai berikut: 
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b. Uji Validitas Soal 

Validitas soal di uji menggunakan SPSS versi 24 for windows. Jika 

hasil analisis r-hitung lebih besar daripada r-tabel maka instrumen soal 

dinyatakan valid, dan jika r-hitung kurang dari pada r-tabel maka instrumen 

soal dinyatakan tidak valid. Berikut langkah-langkahnya: 

Data →  Analyze → Correlate → Bivariate →  Masukkan Variables 

→  Correlation → Cofficientts Pearson →  Ok. 

Uji validitas instrumen soal dilakukan pada peserta didik kelas XII 

MIPA 1 MAN 3 Banjar karena sudah pernah mempelajari materi 

kesetimbangan kimia sebelumnya.  

a. Uji Reliabilitas Soal 

Uji reliabilitas bertujuan untuk mengetahui konsistensi alat ukur yang 

digunakan dalam penelitian. Uji reliabilitas dilakukan menggunakan bantuan 

SPSS versi 24 for windows dengan langkah-langkah sebagai berikut: 

Data →  Analyze→ Scale →  Realibility Analyze →  Masukan Items 

dan Model Alpha →  Statistics → Items, Scale, Scale if Item Deleted, dan 

Inter-Item Correlations →  Continue →  Ok. 

Pengujian konsistensi internal yang digunakan adalah Alpha‟s 

Cronbatch dengan rentang nilai koefisien alpha dari 0 hingga 1. Berikut nilai 

dari koefisien alpha yang dijadikan sebagai pengukuran: 

Crombach‟s Alpha > 0,70, instrumen reliabel 

Crombach‟s Alpha < 0,70, instrumen tidak reliabel. 

 


